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Printing on Envelopes

Guidelines
• Only use envelopes recommended for laser printers. Before you load envelopes in the

Manual Tray, make sure that they are undamaged. 

• Do not feed stamped envelopes.

• Never use envelopes with clasps, snaps, windows, coated lining, or self-stick adhesives.
These envelopes may severely damage the printer.

1 Open the Manual Tray by pulling it down
toward you.

2 Open the rear output tray and pull the
extender.
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3 Load the envelope with the flap side
down. 

The stamp area is on the left side and the
end of the envelope with the stamp area
enters the Manual Tray first.

4 Adjust the guide to the width of envelope.

5 When you print on envelopes, configure
the paper source, type and size properly
in the software application. For details,
see page 5.3.

6 After printing, close the Manual Tray and
the rear output tray.

Printing on Envelopes
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Printing on Heavy Paper

Guidelines

• Heavy paper is any paper heavier than 24 lb (90 g/m2). The maximum paper weight
available for your printer is 43 lb (163g/m2).

• Do not use extremely heavy paper stock (greater than 43 lb, or 163 g/m2 bond).
Misfeeds, mis-stacking, media jams, poor toner fusing, poor print quality, and excessive
mechanical wear can result.

1 Open the Manual Tray and the rear
output tray.

2 Load paper with print side up, and
against the left edge of the tray. 

Adjust the guide to the width of paper.

3 When you print on heavy paper, select
Bond in the Paper Type section.then
configure the paper source, and size in
the software application. For details, see
page 5.3.
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Printing on Labels

Guidelines

• Only use labels recommended for laser printers.

• Verify that the labels’ adhesive material can tolerate fusing temperature of 200°C
(392°F) for 0.1 second.

• Make sure that there is no exposed adhesive material between the labels. Exposed areas
can cause labels to peel off during printing, which can cause paper jams. Exposed
adhesive can also cause damage to printer components.

• Do not feed a sheet of labels through the printer more than once. The adhesive backing
is designed for one pass through the printer.

• Do not use labels that are wrinkled, bubbled, separated from the backing sheet, or
damaged in any way.

1 Open the Manual Tray and the rear
output tray.

2 Load labels with print side up, and
against the left edge of the tray. 

Adjust the guide to the width of paper.

3 When you print on labels, configure the
paper source, type and size in the
software application. For details, see
page 5.3.

Note: To prevent them from sticking
together, remove label sheet from the
output tray as they are printed out.
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Printing on Transparencies

Guidelines

• Only use transparencies recommended for use in laser printers.

• Make sure that the transparencies are not wrinkled or curled, and that they do not have
any torn edge.

• Hold the transparencies by the edges and avoid touching the print side. Oils from your
fingers that are deposited on the transparency can cause print quality problems.

• Be careful not to scratch or leave fingerprints on the print side.

• To prevent transparencies from curling, use the standard output tray. (This is for
transparencies only; for other media, use the rear output tray to reduce curling.)

1 Open the Manual Tray by pulling it down
toward you.

2 Load transparencies with print side
up, and the top with the adhesive
strip entering the printer first. 

Adjust the guide to the width of paper.

3 When you print on transparencies,
configure the paper source, type and
size in the software application. For
details, see page 5.3.

Notes: 

• To prevent transparencies from sticking
together, remove them from the output
tray as they are printed.

• Place transparencies on a flat surface
after removing them from the printer.
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Printing on Preprinted Paper

1 Load letterheads into the tray you want
to use as shown in the figures. 

Adjust the guide to the width of paper.

2 When you print a document on the
paper, configure the paper source, type
and size in the software application. For
details, see page 5.3.

Preprinted paper is paper that has some type of printing placed on it before it is sent through
the printer. (paper that has a preprinted logo at the top of the page, for example)

Guidelines

• Letterheads must be printed with heat-resistant ink that will not melt, vaporize, or
release hazardous emissions when subjected to the printer’s fusing temperature of 400°F
(205°C) for 0.1 second.

• Ink on letterheads must be non-flammable and should not adversely affect any printer
rollers.

• Forms and letterheads should be sealed in a moisture-proof wrapping to prevent changes
during storage.

• Before you load preprinted paper as forms and letterheads, verify that the ink on the
paper is dry. During the fusing process, wet ink can come off preprinted paper.

Load with the design face up, 
top edge toward the printer.

Load with the 
design face down,
bottom edge 
toward the printer.
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Printing on Card Stock or Custom-sized Media

1 Open the Manual Tray. Open the rear
output tray and pull the extender out to
its full-length position.

2 Load print media with print side up,
short edge first and against the left
edge of the tray. 

Adjust the guide to the width of paper.

3 Configure the paper source, type and
size in the printer driver’s properties
(see page 5.3) and print.

Postcards, 3.9 by 5.83 in.(index) cards and other custom-sized media can be printed with the 
ML-1440 printer. The minimum size is 98 by 148 mm (3.9 by 5.83 in.) and the maximum size
is 216 by 356 mm (8.5 by 14 in.).

Guidelines

• Always insert the short-edge into the Manual tray first. If you want to print in landscape
mode, make this selection through your software. Inserting paper long-edge first may
cause a paper jam.

• Do not print on media smaller than 98 mm (3.9 in.) wide or 148 mm(5.83 in.) long.

• Set margins at least 6.4 mm (0.25 in.) away from the edges of the media in the software
application.

Note: If you are using A6-sized paper or
the size of your print media is not listed
in the Paper Size box in the Paper tab
of the printer driver properties, select
Custom Paper and set the paper size
manually.



This chapter explains your printing options and covers common
printing tasks.

Topics included in this chapter are:

◆ Printing a Document

◆ Using Toner Save Mode

◆ Printing on Both Sides of the Paper (Manual Duplexing)

◆ Printing Multiple Pages on One Sheet of Paper (N-Up Printing)

◆ Scaling Your Document 

◆ Fitting Your Document To a Selected Paper Size 

◆ Printing Booklets

◆ Printing Posters

◆ Setting Graphic Properties

◆ Printing Watermarks

◆ Using Page Overlay

◆ Printing on Different Paper for the First Page

◆ Reprinting the Last Page

◆ Printing on a Network Environment

Printing TasksPrinting Tasks55CHAPTER



5.1PRINTING TASKS

Printing a Document

The following procedure describes the general steps required
for printing from various Windows applications. The exact
steps for printing a document may vary depending on the
application program you are using. Refer to your software
application’s documentation for the exact printing procedure.

1 Open the document you want to print.

2 Select Print from the File menu. The Print dialog box for
your application will be displayed (the Print dialog box for
your application may look slightly different). 

The basic print settings you will need are usually selected
within this Print dialog box. These settings include the
number of copies, paper size, and page orientation.

If you see a Properties button,
click it.If you see Setup,
Printer, or Options, click that
button instead; then click
Properties in the next screen.

Make sure your
printer is selected.
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Printing a Document

3 To take full advantage of the printer features provided by
your ML-1440 printer, click Properties in the application’s
Print dialog box and go to step 4. 

If you see Setup, Printer, or Options, click that button
instead. Then click Properties in the next screen.

4 Now you see the Samsung ML-1440 Series printer’s
Properties dialog box. The Properties dialog box allows you
to access all the information you will need when using your
printer.

If necessary, click the Paper tab to display the settings
shown below. The Paper tab contains the options for
setting the basic paper handling.
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Printing a Document

The default paper source is Auto Select. If you use paper
in the Manual Tray or optional Tray2, select the
corresponding paper source. 
Manual Feed source is used when printing to special
media. You have to feed one sheet at a time into the printer.
See page 4.7.
If the paper source is set to Auto Select, the printer
automatically selects the print media according to the
following order: Manual Feed, Tray1, Tray2 (option). 

The default Paper Type is Use Printer Default. If you
load a different type of print media, select the corresponding
paper type. For further information on print media, refer to
chapter 4 ‘Print Media’. 

Also, select the paper size you have loaded in your printer.

The Paper Orientation option allows you to select the
direction in which information is printed on a page. Portrait
prints across the width of the page, letter style. Landscape
prints across the length of the page, spreadsheet style.

����
Landscape

����
Portrait
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5 Click other tabs on the top of the Properties dialog box to
access other features, if needed.

6 When you complete the print settings, click OK until the
Print dialog box is displayed.

7 Click OK to start printing. 

• Most Windows applications will override settings you specify in the
printer driver. Change all print settings available in the software
application first, and change any remaining settings using the
printer driver.

• The settings you change remain in effect only while you are using
the current program. To make your changes permanent , make
them in the Printers folder. Follow this procedure:

1. Click the Windows Start button. 

2. Select Settings , then Printers to open the Printers window.
(Windows 9x/Me/2000)
Select Printers and Faxes . (Windows XP)

3. Select the Samsung ML-1440 Series printer icon. 

4. Click the right mouse button and select Properties to open the
properties window. (Windows 9x/Me)
Click the right mouse button and select Document Defaults to
open the document defaults window. (Windows NT)
Click the right mouse button and select Printing Preferences to
open the printing preferences window. (Windows 2000/XP)

Notes: 

Printing a Document
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There are two ways to stop a print job.

To stop a print job from the ML-1440 printer

Press the Cancel/Reprint button on the control panel. 

The printer will finish printing the page that is moving through
the printer and delete the rest of the print job. Pressing
Cancel/Reprint cancels only the current job in the printer. If
more than one print job is in printer memory, Cancel/Reprint
must be pressed once for each job.

To stop a print job from the Printers folder

1. From the Start menu, select Settings.
2. Select Printers to open the Printers window, then double-

click the Samsung ML-1440 Series. 
3. From the Document menu, select Cancel Printing

(Windows 9x/Me) or Cancel (Windows NT 4.0/2000/XP).

The Samsung ML-1440 printer has a help screen that can be
activated by the Help button in the printer Properties dialog
box. These help screens give detailed information about the
printer features provided by the ML-1440 printer driver. 

If you want to restore the default printer properties settings
when you change the print settings, click Default in the
Samsung ML-1440 Series Properties dialog box.

Cancel/Reprint

Printing a Document

Canceling a Print Job

Printing Help
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Toner Save

Using Toner Save Mode

Toner Save mode allows the printer to use less toner on each
page. Selecting this option will extend the life of your toner
cartridge and reduce your cost per page, but will reduce print
quality.

There are two ways to enable the Toner Save mode.

To enable this feature from the ML-1440 series printer

Press the Toner Save button on the control panel. The printer
must be in the ready mode (Data light is on).

• If the button backlight is on, toner save mode activates and
the printer uses less toner to print a page.

• If the button backlight is off, toner save mode is disabled
and the printer prints in the normal mode.

Note: To enable or disable the Toner Save mode from the control
panel, the Toner Save Mode option in the printer driver must be set
to Printer Setting . See below.

To enable this feature from the software application

1. When you change the print settings from your software
application, access the printer properties. See page 5.2 to
access the printer properties.

2. Click the Graphic tab, and select the Toner Save Mode
option. You can select from: 
• Printer Setting: If you select this option, this feature is

determined by the setting you’ve made on the control
panel of the printer.

• Standard: If you don’t need to save toner to print a
document, select this option.

• Save: Select this option to allow the printer to use less
toner on each page.

3. Click OK.
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Printing on Both Sides of the Paper (Manual Duplexing)

To print on both sides of the paper (manual duplexing), you
must run the paper through the printer twice. You can print
using the top output tray (face down tray) or the rear output
tray (face up tray). Samsung recommends using the top
output tray for light-weight paper. Use the rear output tray for
any heavy media or media that tends to curl when printed,
such as envelopes and card stock.

1 When you change the print settings from your software
application, access the printer properties. See page 5.2 to
access the printer properties.

From the Paper tab, select the paper orientation, source,
size and type.

2 Click the Output tab, then choose Flip on Long Edge or
Flip on Short Edge from the Type drop-down list in the
Manual Duplex Printing section. 
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3 Select Face Down Tray (top output tray) or Face Up Tray
(rear output tray) in which the printed media is to be
stacked. According to this option, the printer will determine
the print page order when the second sides are printed.

If you select Face Up Tray, open the face up tray.

4 If you want to print the instruction page which tells you
how to load the paper, click Print instruction sheet. If
the box is checked, the printer prints the instruction sheet
before the duplexing job is printed. If the box is empty, this
feature is disabled. 

Choosing Flip on Long Edge lets you place the binding
orientation along the long edge of the paper, as in a
magazine. 

Choosing Flip on Short Edge lets you place the binding
orientation along the short edge of the paper, as in a
calendar. 

Printing on Both Sides of the Paper (Manual Duplexing)

2 5
3

2

5
3

2

5
3

2 5
3

����
Flip on Long Edge in the

Landscape orientation

����
Flip on Long Edge in the 

Portrait orientation

➛➛����➛➛����Flip on Short
Edge in the
Portrait
orientation

����
Flip on Short Edge in the 

Landscape orientation
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7 You are prompted to reinsert the paper into the Manual
Tray. Click OK on the screen to start printing the second
side. The printer automatically prints only the even-
numbered pages.

Note: You must press the Demo button to start printing each time
you load the printed page into the Manual Tray.

5 Start printing. The printer automatically prints only the
odd-numbered pages. 

6 Gather up the printed pages, and reload them into the
Manual Tray one sheet at a time in the order that they are
printed.

The following illustrations show you how to put the printed
pages back into the printer.

Printing on Both Sides of the Paper (Manual Duplexing)

Flip on Long Edge in the
Landscape orientation

Flip on Long Edge in the 
Portrait orientation

Flip on Short Edge in the
Landscape orientation

Flip on Short Edge in the 
Portrait orientation

Note: If you have selected the Face Up Tray option in Step 3,
the last page is placed on the top of the stack. Do not
rearrange the pages before reloading them to print the second
side. 

(left edge toward
the printer)

(top edge toward
the printer)

(right edge toward
the printer)

(bottom edge
toward the printer) 

Remove the printed
pages, and reload them
into the Manual Tray one
sheet at a time with the
printed side face down.

Note: Duplexing can cause
the printer to become dirty
more quickly and can
therefore reduce print
quality. See “Cleaning the
Printer” on page 6.4 if the
printer becomes dirty.
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1 2

3 4

You can select the number of pages that you want to print on
a single sheet of paper. If you choose to print more than one
page per sheet, the pages will appear decreased in size and
arranged on the sheet. You can specify up to 16 pages.

1 When you change the print settings from your software
application, access the printer properties. See page 5.2 to
access the printer properties.

From the Paper tab, select the paper orientation, source,
size and type.

2 Click the Output tab, and choose Multiple Pages Per
Side in the Type drop-down list. Then select the number
of pages you want to print per sheet (1, 2, 4, 9 or 16) in
the Pages per sheet drop-down list.

3 Click Print Page Borders if you want to print a border
around each page on the sheet. Print Page Borders is
enabled only if Pages per sheet is 2, 4, 9, or 16.

����4 pages per sheet

Printing Multiple Pages on 
One Sheet of Paper (N-Up Printing)

4 Click OK, then start printing. 



5.11PRINTING TASKS

4 Click OK, then start printing.

Scaling Your Document 

This printer feature allows you to scale your print job on a
page. 

1 When you change the print settings from your software
application, access the printer properties. See page 5.2 to
access the printer properties.

2 Click the Output tab, and select Scale Printing in the
Type drop-down list. 

3 Enter the desired scaling rate in the Scale input field.

You can also click the � or ❷ buttons.
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Fitting Your Document To a Selected Paper Size

This printer feature allows you to scale your print job to any
selected paper size regardless of the digital document size.
This can be useful when you want to check fine details on a
small document. 

1 When you change the print settings from your software
application, access the printer properties. See page 5.2 to
access the printer properties.

2 Click the Output tab, and select Fit to Page in the Type
drop-down list. 

3 You’ll see the Application Paper Size and then you will be
prompted to select the Fit to paper Size. Select the
correct size from the drop-down list.

4 Click OK, then start printing.

A
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����
Portrait orientation

Printing Booklets

8 9

����
Landscape orientation

7
1

9

The Booklet printing feature allows you to print your document
as a 2-sided (duplex) job and to arrange the pages so that the
paper can be folded in half after printing to produce a booklet. 

1 When you change the print settings from your software
application, access the printer properties. See page 5.2 to
access the printer properties.

From the Paper tab, select the paper orientation, source,
size and type.

2 Click the Output tab, then choose Booklet Printing from
the Type drop-down list. 

Then select the paper size you are using from the Booklet
drop-down list.

Note: For booklet printing, only four paper sizes are supported:
Letter, A4, Legal, and Executive.
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3 Select Face Down Tray (top output tray) or Face Up Tray
(rear output tray) in which the printed media is stacked.
According to this option, the printer will determine the print
page order when the second sides are printed.

If you select Face Up Tray, open the face up tray.

4 If you want the instruction page which tells you how to load
the paper, click Print instruction sheet. If the box is
checked, the printer prints the instruction page before the
duplexing job is printed. If the box is empty, this feature is
disabled. 

5 Print the document. 

6 The printer prints side one as shown below for an 8-page
document.

Printing Booklets

��������8 page document

6 3

7 Gather up the printed pages, and reload them into the
Manual Tray one sheet at a time. Go to the next page for
details on reloading the printed pages.

8 1
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Printing Booklets

The following illustrations show how to put the paper back
into the printer.

Note : If you have selected
the Face Up Tray option at
Step 3, the last page is
placed on the top of the
stack. Do not rearrange the
pages before reloading the
pages. 

8 9

8 You are prompted to reinsert the paper into the Manual Tray.
Click OK on the screen. The printer will finish printing.

9 Fold and staple the pages.

���� Face Up Tray output ��������Face Down Tray output

In Landscape orientation,
insert the pages with

bottom edge 
toward the printer.

In Portrait orientation,
insert the pages with 

left edge 
toward the printer.

���� Face Up Tray output ���� Face Down Tray output

Remove the printed
pages, and reload them
into the Manual Tray one
sheet at a time with
printed side face down.

Note: You must press the Demo button to start printing each
time you load the printed page into the Manual Tray.
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Printing Posters

This feature allows you to print a single-page document onto
4, 9, or 16 sheets of paper, for the purpose of pasting the
sheets together to form one poster-size document.

1 When you change the print settings from your software
application, access the printer properties. See page 5.2 for
more information on accessing printer properties.

From the Paper tab, select the paper orientation, source,
size and type.

2 Click the Output tab, and select Poster Printing in the
Type drop-down list.

����
Poster printing
with 2x2 style
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Printing Posters

➛➛����➛➛����2 x 2 ➛➛����➛➛����3 x 3

������������Overlap=0 ������������Overlap=0.3

0.3 inches

0.3 inches

5 Click OK, then start printing. 

3 To determine the scaling factor, select the Style; 2x2, 3x3
or 4x4.

For example, if you select 2x2, the output will be
automatically stretched to cover 4 physical pages.

4 You may specify an overlap in millimeter or inch to make it
easier to reconstruct the resulting poster.
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You can select the printing resolution by choosing either 
300 DPI or 600 DPI. The higher the setting, the sharper the
clarity of printed characters and graphics. Higher settings may
increase the time it takes to print a document.

Resolution

Use the following options to adjust the print quality for your
specific printing needs when you access the printer properties.
See page 5.2 for more information on accessing printer
properties. 

If necessary, click the Graphic tab to display the settings
shown below.

Setting Graphic Properties

Click here to save
the changes when
setting is done.
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Setting Graphic Properties

Use this option to lighten or darken the image appearance in
your print jobs.

• Normal – This setting is for normal documents.

• Light – This setting is for bolder line widths or darker gray-
scale images.

• Dark – This setting is for finer line width, higher definition in
graphics, and lighter gray-scale images.

Darkness

When the Dark Text is checked, all text in your document is
allowed to print darker than normal document. 

Dark Text

When the All Text to Black is checked, all text in your
document is allowed to print solid black, regardless of the color
it appears on the screen. 
When it is not checked, colored text is allowed to print in
shades of gray.

All Text to Black

You can set the printer not to print the last page of the last job
when the Cancel/Reprint button is pressed. For details, see
‘Reprinting the Last Page’ on page 5.29.

Reprint
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Setting Graphic Properties

To conserve power when a printer is idle, you can set the
printer to enter a reduced power state after completing a print
job, according to a time specified by you in the Power save
Mode box.

Select the desired length of time from the drop-down list.

If your printer is constantly used, select OFF to keep the
printer ready to print with the minimum warm-up time. This
uses more energy to keep the printer warm and ready to print.

Power Save Mode

With this option ON, the printer keeps the image for a printed
page until the printer signals that the page has successfully
exited the printer. If a paper jam occurs, the printer will
automatically reprint all jammed pages after the jam is
cleared.

Reprint When Jam
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Printing Watermarks

The Watermark option allows you to print text over an existing
document. For example, you may want to have large gray
letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally
across the first page or all pages of a document.

There are several predefined watermarks that come with the
ML-1440 series printer, and they can be modified or you can
add new ones to the list.

1 When you change the print settings from your software
application, access the printer properties. See page 5.2
for more information on accessing printer properties.

2 Click the WaterMark tab, and select the desired
watermark in the Message drop-down list. You will see 
the selected watermark in the preview window.

3 Click OK, then start printing.

To use an existing
watermark

preview window
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Printing Watermarks

1 When you change the print settings from your software
application, access the printer properties. See page 5.2 for
more information on accessing the printer properties.

2 Click the WaterMark tab, and enter the desired text
message in the Text field. This will be displayed in the
preview window. The preview window is provided so that you
can see how the watermark will appear on the printed page.

3 Select the desired watermark options. You can select the
font type and size, color and angle. There are three
checkboxes at the bottom of the dialog box:

• Transparent Text – Allows the document to show
through the watermark.

• As Outline only – Prints the text outline of the
watermark. This setting globally effects
all watermarks in the list.

• On First Page only – Prints the watermark only on the
first page.

To create or edit a
watermark

Use these scroll
bars to adjust the
position.
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Printing Watermarks

4 If you have created a new or edited an existing watermark,
the Add and Update button is enabled.

To add a new watermark to the list, click Add.

5 If you want to edit, select the desired watermark from the
list, edit, then click Update. 

6 When you complete the edit, click OK, then start printing.

To stop printing the watermark, select None in the Message
drop-down list.

1 When you change the print settings from your software
application, access the printer properties. See page 5.2 for
more information on accessing the printer properties.

2 From the WaterMark tab, select the watermark you want
to delete in the Message drop-down list. 

3 Click Delete.

4 Click OK.

To delete a watermark
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Using Page Overlay

An overlay is text and/or images stored in the computer HDD
as a special file format that can be printed on any document
you choose. Overlays are often used to take the place of
preprinted forms and letterhead paper. Rather than using
preprinted letterhead, for example, you can create an overlay
containing the exact same information that is currently on
your letterhead. Then when you want to print a letter with
your company’s letterhead, you do not need to load preprinted
letterhead paper in the printer. You need only to tell the
printer to print the letterhead overlay on your document.

What is an Overlay?

WORLD BEST

Dear ABC

Regards

To use a page overlay, you must create a new page overlay
containing your logo or image.

1 Create or open a document containing a text or image you
want to use for page overlay. Position the items exactly as
you wish them to appear when printed as an overlay. If
needed, save the file for later use.

2 Select Print from the File menu. Then click Properties in
the application’s Print dialog box to access the printer
properties. For details, see page 5.2.

3 Click the Overlays tab, and click Create Overlay.

Creating a New Page
Overlay

WORLD BEST
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4 In the Create Overlay dialog box, type a name of up to
eight characters in the File name box. Select the
destination path if necessary. (The default is
C:\FORMOVER).

5 Click Save. You will see the name in the Overlay List box.

6 Click OK or Yes until you complete the creation. 

The file is not printed out. Instead it will be stored on your
computer HDD disk. 

Note: The overlay document size must be the same as documents
you will print with the overlay. Do not create overlay with the
watermark.

Using Page Overlay

Using Page Overlay After an overlay has been created, it is ready to be printed
with your document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 When you change the print settings from your software
application, access the printer properties. See page 5.2 to
access the printer properties.

3 Click the Overlays tab, and select the desired overlay from
the Overlay List box. 
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4 If the desired overlay file does not appear in the Overlay
List box, click Load Overlay, and select the overlay file. 

If you have stored the overlay file you want to use into an
external source, you can also load the file when you access
this Load Overlay window.

After you select the file, click Open. The file is now shown
in the Overlay List box and is available for printing. Select
the overlay from the Overlay List box. 

Using Page Overlay
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You can delete page overlays that are no longer used.

1 In the printer properties dialog box, click the Overlays tab.

2 Select the overlay you want to delete from the Overlay
List box. 

3 Click Delete Overlay.

4 Click OK until you exit the Print dialog box.

Deleting a Page Overlay

5 If necessary, click Query Page Overlay. If this box is
checked, a message box will appear each time you submit
a document for printing, asking you to confirm your wish to
print an overlay on your document. 

Answering Yes to the message box means that the
selected overlay will be printed with your document.
Answering No to the message box cancels overlay printing.

If this box is empty, and an overlay has been selected, the
overlay will be automatically printed with your document.

6 Click OK or Yes until the printing starts.

The selected overlay will be downloaded with your print job
and printed on your document.

Using Page Overlay

Note: The overlay document resolution must be save as document
you will print with the overlay.


